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Chapter 1: Welcome to System Configuration

1.1 What is System Configuration ?

Purpose

The purposes of this program are:

o to set up the individual stations of the IGSS system (single user, server or operation sta-
tions)

o to enable the communication between IGSS and the data collection devices (typically
PLCs) in the plant

o to configure the relevant communication drivers

Use

With the System Configuration program you can:

o Define the station type and name of the individual stations in the system
e Include up to 8 drivers that can run simultaneously in IGSS

e Choose the relevant interface(s) for the driver

e Define the required nodes and subnodes

The typical workflow

To put System Configuration into a broader perspective, here is an outline of the typical work-
flow when you set up a multiuser system.

1. Create the new configuration in System Configuration.

2. In System Configuration, define the IGSS servers and operator stations.
3. Define the setup parameters for the servers.

4, Define the setup parameters for the operator stations.

5. Include the drivers you want to use and set up the individual nodes (PLCs).
6. Design and install the configuration in Definition.

7. Start and test the configuration (IGSS Starter and Supervise)


igss.chm::/Help_Glossary_Query_driver.htm
igss.chm::/Help_Glossary_Query_driver_interface_System_Configuration_.htm
igss.chm::/Help_Glossary_Query_node.htm
igss.chm::/Help_Glossary_Query_subnode_System_Configuration_.htm

Key features and benefits

For a detailed list of features and benefits, click here.

Program components

The System Configuration program consists of the following key components:

Component Description Location
SysConfig.exe Program executable [InstallPath]\Gss\
[MyDriver].dll Two DLLs for each [InstallPath]\Gss\

driver supported. The
driver DLL and the con-
figuration DLL.
For example,

7TAB.DLL and

7TABC.DLL.
SysConfig.chm The Help file for the [InstallPath]\Gss\
System Con- [Language Code]

figuration program.

DrvSpec.chm The driver-specific [InstallPath]\Gss\
Help file with infor- [Language Code]
mation about the
individual drivers and
error codes.

DrvEvent.chm The Help file which [InstallPath]\Gss\
describes how to use |[Language Code]
event-oriented com-
munication with IGSS.

1.2 The User Interface

Main window

The main window consists of four elements:

e The menu bar
e Thetoolbar area
e Thetree view

e The property pages area


../../../../../Content/Drv_WELCOME_Key_features_and_benefits.htm
../../../../../Content/Drv_WELCOME_Key_features_and_benefits.htm

Click on any part of the figure below for further information.

1ii 1GSS - System Configuration c:\configsYigssv7\doc\demo '._ E'E'
File Edit Wiew Tools Help
e =& x 7 N2
”ﬁti':'r' name: demao Supervize & Language Ctartup D ata Collection Reports
=AlGo55ervar_L Station | Configuration Files Access Contral &larmm
® 1G555erver_2 S sl
=l o roperties
[ .
E gig g Station type: | Server 1 in dualized system b
[
= OP4 Computer name: PFRAISTA
G55 station name assigned to this PC
G55 station name; |||3555&rver_1 | ID: | |
IP addresz(es)
First address: | |
Backup address: | |
Statistics
m Dirivers: 3
Top nodes: 1 Sub nodes: 1
Motz
Enter a zhart description of thiz station if needed.
For Help, press F1 LM
Menus

The following menus are available. To get a detailed description of each menu item, click one of
the menus below.



File menu
Edit menu
View menu

Tools menu

Help menu

Right-click menu

Right-click menus

In the tree view pane, a context-sensitive right-click menu is available for adding or removing
elements and to expand or collapse the selected branch of the tree view.

To see what a menu item does, click its name below.

This PC

Preset Station

New Station
New Driver
New Node

New Subnode)

Remove Station, Driver, Node or Subnode

Suspend Driver
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Suspend Device

Suspend Node

Expand Branch (right-click menu)

Collapse Branch (right-click menu)

The toolbar

To see what a button does, click it in the following illustration.

BEE 28 Lot T K&
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Chapter 2: Setting up IGSS Servers and Operator Stations
2.1 Overview

How it works

Downloading or uploading the system configuration

In a multiuser system, the settings from System Configuration are saved in the con-
figuration database, [MyConfig].mdb. This file is one of the four core configuration files shown
in the illustration below.

Typically, the IGSS configuration and the system configuration are maintained on the IGSS
server. When changes are made to either, they are automatically downloaded to the operator
stations in the system.

It is also possible, however, to make changes to the configuration or the system configuration
on one of the operator stations and then upload those changes to the IGSS server. In that case,
the changes are first uploaded to the IGSS server which, in turn, makes sure that all the remain-
ing operation stations are updated.

Overview

The illustration below gives you an overview of how the system configuration is distributed in a
multiuser system.
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The following steps outline how you set up a multiuser system the first time. For detailed step-
by-step procedures, refer to the "How To" book in the Table of Contents.

1. The configuration is created on the IGSS server.

2. All the stations of the system are defined and set up.

From the IGSS Server you can set up the parameters for all the

stations in the system. This makes it a lot easier to make the

setup of the individual stations consistent.

3. The communication drivers and PLCs are set up.

4. The mimic diagrams are configured on the IGSS server and the IGSS configuration is

installed.

5. On each operator station, the following is done:



¢ Open the System Configuration program and specify the station type and
name. The name must be exactly the same as the one specified on the IGSS
Server.

e Launch the IGSS Starter program. When prompted for the server's address, spec-
ify the IP address of the IGSS Server.

e The IGSS configuration is now downloaded including the file [MyConfig].mdb
which includes the entire system configuration.

6. When you subsequently open the System Configuration program on the operator
station, the appropriate station name will be highlighted in the tree view. The param-
eters for the station have also been downloaded from the IGSS Server.

7. The IGSS configuration is now identical on all stations of the system. When changes
are made on one of the stations in the system, they are automatically distributed to
the other stations of the system. If required, the system can be set up to display a
message before changes are downloaded or uploaded.

Brief description of station types

The following descriptions give an overview of the different station types available in the IGSS
system. Setting up of station types is done in the System Configuration module.



s

For Help, press F1

[G55 - 3ystern Configuration diigss configshscada projecthdemo E@
File Edit ‘“iew Tools Help
2= = T K2 &
Configuration name: demao Supervize & Language | Startup | Data Collection | Reports
+Q IGS5 Server 1 Station | Configuration | File= | Access Control I Alarm
..... (8] 1G5 Server 2 s
----- CP1
..... Qpz g Statiar t}'DE:[Sewer 1 in dualized spstem v]
..... Qp3 Server
Q Qpd Computer name: PFR- Single User
""" IGSS station name a Server with A8 switch, Primary
----- CP5

Server with &8 switch, Secondar

Server 1 in dualized system
Server 2 in dualized syste
Operator Station

G55 station name:

IP addresz(esz] Operator Statinn, Si_ng!e I zer S,awer Backup
First address: Operator Station, Digtibuted Driver [Backup]
Backup address:

Statistics
m Dirivers: 4

Top nodes: 1 Sub nodes: 1]
MHaotes

Enter a zhort degcription of this station if needed.

MLURA

Station type Description
(name)

Server The station type configured on the PC to be used as IGSS
server in a network where one or more operator stations are
also present.

Single User The station type chosen in a system with only one PC acting as
both operator station and server.




Station type
(name)

Description

Server with A/B
switch, Primary

This is a station type used in a redundant system. Selecting this
station type sets up the Primary server in the network and this
must be later paired with the corresponding Secondary server,
which is the hot standby server.

The solution is used mainly in cases where data is collected
from remote locations with only one communications line into
the central server site feeding data to the Primary server. The
feeder line can then be switched (software wise or hardware
wise) from the Primary to the Secondary server in the network.
This switching feature also enables altering the IGSS system on
the Secondary server while the Primary server is running.
When changes are complete, operator stations are switched to
this server, which now becomes the Primary server.

Server with A/B
switch, Secondary

Server 1 in dual-
ized system

The backup server station which is set up with a switch in event
of Primary server failure. (See the description above for
Server with A/B switch, Primary.)

The primary server in a normal, dualized system. Network con-
nections to all the same PLCs as Server 2 in a dualized system.

Server 2 in dual-
ized system

Operator Station

The hot standby server station in a normal, dualized system.
Network connections to all the same PLCs as Server 1 in a dual-
ized system.

The station type selected to function as a control and mon-
itoring station in the network from which plant personnel carry
out their duties.

Operator Station,
Single User
Backup

Under normal operation the station functions as an ordinary
operator station as long as there's a connection between it and
the IGSS server. If, however, the connection between the
server and the operator station fails, then this station auto-
matically restarts as Single User Backup and will go into one
of the following modes:

Complete backup of the IGSS server: If the station has
been configured in the System Configuration module with-
out further underlying resources, then when it starts up in
backup mode, it will assume the same function as the first
server defined in the station tree. In other words, it will con-
nect to the same nodes as the IGSS server originally was con-
nected to and also fetch data from distributed drivers, if
present.

Limited backup of IGSS server. To prevent selected PLC
drivers present on the IGSS server from being activated when




Station type

(name) Description

the Operator station goes into backup mode, open the System
Configuration module, select the driver in question in the
tree view on the left, click on the Advanced tab on the right,
find the checkbox Single user backup and clear it.

Controlled backup of the IGSS server. If in System Con-
figuration, driver and node resources have been set up for
Operator Station, Single User Backup, then these will be
activated when the station goes into backup mode. This type
of operator station is thus able to activate more or fewer
resources than are found on the IGSS server itself. If the
backup station is to activate more drivers or nodes than the
server, then these resources must be defined on the IGSS
server as de-activated resources in order to be available for
configuration purposes in the Definition module.

Operator Station, Dis-] The station functions as an operator station and activates driv-
tributed Driver er(s) for the PLC(s) to which it's physically connected. The sta-
tion collects process data and sends this data on to the IGSS
server. The distributed driver solution is typically chosen in
cases where PLCs are located at remote locations thus making
it impractical to cable the PLC directly to the IGSS server..

gl Defining the stations in the system

Introduction

For each station in your IGSS system, you need to define a nhumber of properties. These prop-
erties include the IGSS station type and station name.

The Station tab

When you define a station, the Station tab appears allowing you to choose the relevant station
type and define a unique station name. When you choose a station type, the relevant set of
properties and options will appear.

Multiuser systems



In a multiuser system, define all the stations in the system from the IGSS Server. On each oper-
ator station, enter the System Configuration program and specify the station name exactly
matching the one specified on the server. When the operator station establishes connection to
the server, the configuration will be downloaded. IGSS will recognize the station name. If you
open the System Configuration program again, this station name will be highlighted.

Single user and server setup

If you define one of the following station types, a humber of setup tabs will appear in the right
pane.
Click here for further details:

e Server

e Single user

e Server with A/B switch, Primary

e Server with A/B switch, Secondary

e Server 1 or 2 in dualized system

Operator station setup

If you define one of the following operator station types, a limited number of setup tabs will
appear.

Click here for further details:

e Operator station
e Operator station, Distributed Driver (Backup)

e Operator station, Single User Server Backup
Setting up an IGSS server or single user

Introduction

When you select an IGSS server or single user station in the tree view, a number of setup tabs
appear in the right pane.

This topic gives you an overview of the functionality. Click here for the step-by-step procedure.

Example

In this example, we're looking at an IGSS server in a dualized system.



igss.chm::/Help_Glossary_Query_dualized_server.htm
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1ii 1GSS - System Configuration c:\configstigssv7\docidemo
File Edit “ew Tools Help

e =& x 7 N2
"'Fiti':"" name: demo Supervise & Language Startup D'ata Collection Reparts
= """— Station Canfiguraticr Filex Access Contral Alarm
) BrvEr_ .
®) o Froperties
ml op2 . . .
E op Station type: | Server 1 in dualized system b
=l opg

Computer name: PFRAISTA
G55 station name aszigned to this PC

G55 station name: |IGSSSewer_1 | ID: | |

|F addrezz(es]
Firzt address: | |

Backup address: | |

Statizticz
m Dirivers: 3
Top nodesz: 1 Sub nodes; 1

M otes

Enter a zhort description of thiz station if needed.

Faor Help, press F1

LM

Overview of setup tabs

The table below gives you an overview of the setup tabs available for an IGSS server or single

user station.

For help on the individual item on the tab, click the k? then click on the item.

On this tab

You define the following

Station

Station type (server, operator station, etc.) and sta-




On this tab You define the following

tion name.

Configuration Data management parameters such as scan inter-
vals, base intervals and logging deadband.

Files The lifetime of the key data files (alarm, log and .bcl
files) and hour, day and month values for the stand-
ard reports. Furthermore, setup of synchronization
of data files between a primary server and a dual-
ized server.

In the Backup field, a path is keyed in to the backup
folder on the hard disk, and when the system is run-
ning, IGSS files are automatically backed up to the
designated location.

Access Control Key settings for the user administration functionality
and setup of users for the Super Alarm program.

Alarm Customization parameters for the Alarm program,
for example, locking of alarm window and icon posi-
tions, alarm counter settings, etc.

Supervise & Lan- |Customization parameters for the Supervise pro-
guage gram, for example, locking of size and position of
process diagrams and graphs.

Startup Startup mode and auto start of IGSS utility pro-
grams (Job Scheduler, WinPager, etc.).

Data Collection Parameters for the Data Collection engine: sim-
ulation mode, logging of PLC driver communication
packets, etc.

Reports Setup of the alarm and log printers, report header
and logo.

Setting up an operator station

Introduction

When you select an operator station in the tree view, a limited number of setup tabs appearin
the right pane.

This topic gives you an overview of the functionality. Click here for the step-by-step procedure.

STEP 1: Define the connection to the IGSS server



The first time you open the System Configuration program, it is assumed that you've defined
all the stations in the system on the IGSS server. The next step is to identify the current oper-
ator station and define the connection to the IGSS server(s). The latter is done on the Server
& Backup tab.

STEP 2: Download the configuration from the IGSS server

Once the connection is defined, download the configuration from the IGSS server. The following
core configuration files will be downloaded to the operator station:

« [MyConfig].elm - The main configuration file
¢ [MyConfig].dsc - The descriptor1 file (information about the graphical display of
objects)

« [MyConfig].mdb - The configuration database (object names, descriptions, alarm texts,
the system configuration, etc.)

e [MyConfig].ocf - The OLE Compound File (information about ActiveX, OLE and VBA/Au-
tomation)

STEP 3: Set up the operator station

Open the System Configuration program again. It will now show you all the stations in the
system. Select the current operator station and go through the setup tabs outlined below.

Example

The program allows you to customize the settings, for example, for the Supervise and Alarm
programs. Most importantly, you define the connection to the IGSS server on the Server &
Backup tab.

1a descriptor is the graphical display of an object. IGSS includes many types of descriptors
including: - Built-in standard symbols - Animated symbols (Symbol Factory library) - Graphics
and animation - Drawing symbols - Windows controls - ActiveX controls An IGSS object can be
represented with different descriptors on different diagrams.



1ii 1GSS - System Configuration c:\configstigssv7\docidemo
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nFigurati-:nn name: demo Supervise & Language Alarm Access Control Reparts
=y [G355erver_1 Station Server & Backup Startup
ml 15555erver 2

B opp Froperties

% P2 IP address of IGS5 server

=) OP3 Prirary zerver

=l opg

1GSSServer_t | [ Advanced... |

Secondary zerver

| | [ Advanced... ]
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G
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Overview of setup tabs

The table below gives you an overview of the setup tabs available for an operator station.

For help on the individual item on the tab, click the k? then click on the item.

On this tab

You define the following

Station Station type and station name.




On this tab You define the following

Server & Backup | The connection to the IGSS server(s) and backup sys-
tem options (if you've purchased a Dualized System
or Single-User Backup license).

Startup Startup mode and auto start of IGSS utility programs
(Job Scheduler, WinPager, etc.).

Supervise & Lan- | Customization parameters for the Supervise pro-
guage gram, for example, locking of size and position of
process diagrams and graphs. The language is also
chosen here.

Alarm Customization parameters for the Alarm program,
for example, locking of alarm window and icon posi-
tions, alarm counter settings, etc.

Access Control Key settings for the user administration functionality
and setup of users for the Super Alarm program.

For the station types Operator Station, Distributed Driver (Backup) and Operator Sta-
tion, Single User Server Backup, the driver(s) must be able to run on the operator station.
Thus the data collection parameters must be set up for this station.

Data Collection |Parameters for the Data Collection engine: sim-
ulation mode, logging of PLC driver communication
packets, etc.

Redundancy solutions in IGSS

Introduction

There are two basic types of redundancy solutions available in the IGSS system: the hot
standby server, also known as the dualized server, and the single-user backup server. These
redundancy options are safeguards against lost production output or safety hazards arising from
the absence of on-line surveillance data. Their characteristics are described in further detail in
the following.

Note

Neither solution is included in the standard IGSS package. They must be purchased separately.

Hot standby (or dualized) server



As the name implies, this solution protects your system against server failure. By setting up a
second, or dualized server, uninterrupted process surveillance and control is assured. The dual-
ized server runs in parallel to the primary IGSS server in hot standby mode. All process data
received by the primary server is also received on the dualized server. Upon primary server fail-
ure, the hot standby server takes over the full server function both with respect to data col-
lection and communication with plant surveillance workstations. There is no loss of data or loss
of process control due to blackouts.

After recovery, the primary server resumes its normal function. The data collection gap present
on the primary server, which occurred when it was "down", is remedied by fetching the missing
data from the hot standby server when the primary serveris brought back on-line.

Hot Standby Server
Surveillance workstations

A/B switch

This option is only chosen in the following two specific situations. The first is when there is only
one transmission line available for communication between the IGSS server and remote PLCs.
This might be the case, for example, in a context where the expense of leasing a second trans-
mission line for communicating with outlying PLCs would be prohibitive. The second situation is
when the PLCs are unable to communicate effectively with 2 servers simultaneously due to PLC
resource limitations of one kind or another.

The A/B switch can be implemented as a software solution only, or with a physical hardware
switch.



In the hardware switch solution, the A/B switch box is installed with one switch position con-
nected to each of the two servers, the primary server and the hot standby server. Additions or
modifications to the running configuration can be implemented on the hot standby server by an
administrator. When the changes are completed, the administrator switches plant surveillance
workstations over to the hot standby server and then uploads the new configuration to the pri-
mary server. After the new configuration is in place on the primary server, the administrator
once again switches surveillance workstations back to the primary server and the new con-
figuration becomes the newest, valid operations configuration. The A/B switch is placed at the
LAN/WAN periphery to control to which server data collection from remote PLCs is to be
directed.

Workstations are automatically switched to the hot standby server while the new configuration
is being uploaded to the primary server, and back again when the new configuration is running
on the primary server. These workstations need not be informed of the changes and are
switched back and forth between the servers automatically.

In the event of Primary server loss, the Secondary server goes into operation automatically and
takes over as (new) Primary server. While the original Primary server has been in operation, all
its data has automatically been replicated onto the Secondary server.

(Implementation of this solution requires the following hardware from, for instance, Black Box:
Ganged Switching System, Remote System Gang Controller and an RS-232/V.24 Line Sharer.)

Operator Stations
—~ -
primary | | fumit 0~/ Hot Standby
Sarvar Servar

In the "soft switch" solution, the primary and the hot standby server are both connected to the
PLCs. This solution assumes that the individual PLCs have two connections available to the
data communication network. No other hardware is required.



Soft Switched Hot Standby Server
Surveillance warkstations

For both A/B switch solutions, the appropriate station type for the servers must be correctly
selected in the System Configuration program. In this case, AB primary must be selected for
the primary IGSS server, and AB secondary must be selected for the hot standby server.

Single-user backup server

Another type of redundancy is the single-user backup server. This solution is often used in
remote locations where process data collection and plant control must continue even in the
event of a communications line failure into the IGSS server, orin situations where protection of
only selected components in a plant is required.

The single-user backup server is set up on an ordinary plant surveillance workstation. In the
event of failure of the IGSS server, the workstation then restarts as a single-user backup server
and fulfills the functions of both surveillance workstation and server at the same time. The proc-
ess components to be safeguarded here must, of course, be connected to the single-user
backup server in addition to having been connected to the IGSS server.

If there is a need to maintain access to historical data when the IGSS server fails and the sin-
gle-user backup server takes over, then installation of a separate file server which stores his-
torical data is recommended.



Single-User Backup

Surveillance wiarkstations Single-user backup-server

PLCs

2.2 Add and Manage Stations

gl Add a new station

In a multiuser system, define all the stations and assign the appropriate station type.

1. Select Edit > New Station or click the icon in the toolbar.
A new station appears in the tree view.

You can also add a new station using the New Configuration
Wizard. In the File menu select New Configuration Wizard
or click the 'ﬁ icon in the toolbar. Follow the on-screen instruc-

tions.

2. Inthe Station type drop-down list, select the appropriate type. The number of
options available depends on the chosen station type. Click the relevant type below
to continue:



Important: In a multiuser system all stations must be defined in System Configuration.
This is typically done from the IGSS Server.

Add a single user or server station

Add an operator station

Edit station properties

1. Inthe tree view, select the station whose properties you want to change.

2. Edit the properties, as required.

E Remove a station

1. Inthe tree view, select the station you want to remove.

2. Select Edit > Remove or click the above icon.

2.3 The IGSS Data Server

The IGSS Data Server

The challenge

Throughout the years the volume of data collected and logged by IGSS for graph and reporting

purposes has increased dramatically. In larger installations, this means that a simple operation
as viewing a graph involves reading several Gigabytes of data. Luckily, the capacity of modern
networks have grown almost just as fast as the volume of IGSS LOG data in typical LAN instal-
lations.

However, in multiuser systems where one or more operator stations are connected to the IGSS
Server with a WAN connection, problems may arise. The response time for an IGSS graph in
WAN solutions could be way too long.

The solution
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To overcome the above problem, 7T has invented the IGSS Data Server, which optimizes the
use of the bandwidth between the IGSS Server and the WAN operator station. These operator
stations will see a significant improvement in the response times when opening LOG-based
graphs.

Activating the IGSS Data Server

The IGSS Data Server must be activated on the IGSS Server. It will by default run in the back-
ground without any user interface. When an operator station connects to the IGSS Server, it will
detect whether the Data Server is runnning. If so, it will automatically use the Data Server
when fetching data for LOG-based graphs. If the Data Server is not activated, data fetching will
be done as in earlier versions of IGSS.

Auto starting the IGSS Data Server

To auto start the Data Server, simply select the Data Server check box on the Startup tab for
the IGSS Server.

Manually starting the IGSS Data Server

You can start the Data Server manually by typing this command in the Windows Command
Prompt:

The following user interface will then appear:



1 1GSSDataServer

Server Information Active Clients

Server State: Running.. 172.16.12.119:60567
Active Clients: 1

Session Count: 3

Drata Sent (KB]: 17271 Kb

D ata Recy [Bytez): 38

Recaords Sent: 441702

Records Examined: 2356020

Server Log

200310422 14:06:44 Sezzion started [172.16.12.113:60867) [ o
200310422 14:06:16 Session ended. [172.16.12.113:52375] Bunning 321 m5Secs. —l
200310422 14:06:15 Sezzion started [172.16.12113:52375)

2009470422 09:30:58 Sezsion ended. [17216.12.1193.57391]. Bunning 937 mSecs.

200310422 03:30:57 Sezzion started [17216.12113:67331)

2009410422 09:24:01 Sezzion ended. [17216.12.11912673). Bunning 20688 mSecs.

200910422 09:23:40 Session started [17216.12112:12679)

200910422 09:22:04 Seszszion ended. [17216.12.1193:64390]. Running 985 mSecs.

200910422 09:23:03 Session started [172.16.12.115:64390)

200940421 14:52:30 Sezsion ended. [17216.12.113:65153]. Running 922 mSecs.

200310421 14:53:29 Session started [172.16.12.115:65153)

2009490421 14:46:15 Sezzion ended. [172.16.12.113.:37505]. Running 922 mSecs.

200310421 14:46:14 Sezzion started [172.16.12.115:37508)

2009470421 14:353:25 Sezzion ended. [172.16.12.113:19328]. Running 922 mSecs.

200310421 14:39:24 Sezzion started [17216.12.115:19328)

200370421 14:27:45 Session ended. [172.16.12.113:50559]. Bunning 244 mSecs.

200310421 14:27.44 Sezzion started [172.16.12.113:50853) [ ||

[ Start Server ] [ Stop Server ] [ Exit Server

It shows the following information:

o Server state (running, stopped)
o Number of active clients (operator stations)

e Various data statistics

You can run the Data Server in hidden mode. Simply right-click the icon in the upper left corner
of the window and select Hide.

Port numbers used

Port number 12401 must be open on the IGSS Server to allow communication with the IGSS
Data Server. If you are using a firewall, this port must be open.




2.4 Synchronization of Dualized Servers

What is synchronization of dualized servers ?

When using an IGSS dualized server solution, which is a hot standby server solution, the Dual

Server Synchronization utility -i is used to ensure that both servers are identical.

The utility can be run on any PC in the network where the IGSS software has been installed. For
example it could be run from one or the other of the two server PCs in the dualized system, from
an IGSS operator station or from a dedicated PC, which only runs Dual Server Syn-
chronization.

Important: Never run the Dual Server Synchronization utility from more than one PCin the
network. Doing so will result in errors for which no warning will be given.

There are certain parameters that are not automatically updated between the servers. These
are typically configuration changes, which are not reflected in the PLCs to which the two servers
in the dualized system are connected.

The Dual Server Synchronization utility is used for updating these parameters, which are:

Parameter name What it is

Local object Objects not found in the PLCs to which both servers
are connected in a dualized system, i.e. objects
created "locally" on the one or the other server.

Local ACK Acknowledgement of alarms where the alarm atom
is set to local on the Edit Mapping tab under I/0
mode.

Alarm inhibit Operator initiated alarm blocking, which always orig-

inates "locally" due to operating personnel decision
in light of specific situations.

In Definition you can create a digital object to monitor the states
of the two dualized servers. For more info, click here.
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To activate the synchronization function, double click on the SYNC icon —i found in the
IGSS program group and the Sync Server Configuration dialog box appears.

To continue with the next steps in setting up the Sync Server, click here.

Configuring Sync Server parameters

1. Make sure that the two IGSS servers in the system are up and running.

Click on the SYNC ico
figuration appears.

Sync Server Configu

ration ¥7.00.00. 7015

n —i , and the dialog box called Sync Server Con-

SERVER &
P Addresz

SERER B
P Addresz

Configuration

Sent to Server B
Local object

Local ACE,
Alarrn inhibit

Configuration

Sent to Server b

0 Local object 1]
Local ACE,
Alarrn inhibit
] Upload new cqnfiguratiun [{a]
zerver automatically
] (=




3. Key in the respective IP addresses for SERVER A and for SERVER B.
4. Click on the Start Sync button.

The Sync Server application will now connect to the two servers and check if the two IGSS con-
figurations are identical. If this is not the case, then you must choose which server to upload to
and click on the appropriate button.

Example: You click Start Sync and the message appears telling you that Server A is old (com-
pared to Server B). But before synchronization can take place, the two must be identical. There-
fore, you would click the button Upload to Server A.

To upload automatically, select the checkbox Upload new configuration to server
automatically

For a description of the parameters Local object, Local ACK and Alarm inhibit, click here.

Important: Sync Server will only synchronize objects if the configurations on the two servers
are found to be identical.



Chapter 3: Setting up PLC Drivers
3.1 Driver Setup
Overview

@ Overview: IGSS drivers

Definition

An IGSS driver is a control program enabling the system to communicate with the devices (typ-
ically PLCs) which control the process. 7-Technologies has developed drivers for a wide range
of communication protocols.

Use

You set up the driver(s) for a given configuration in the System Configuration program.
Once defined, you can select these drivers in the Definition program and they will be acti-
vated when you start the configuration.

How it works

Click here to get a graphical overview of how drivers are defined.

Types of drivers

The supported PLC drivers can be divided into two main groups:

e PLCs using polled communication

e PLCs using the SICOS protocol (event-based communication)

If your driver is using the SICOS protocol, additional parameters must be specified.

The interface(s) and topology supported by the individual drivers differ. The visual pre-
sentation in System Configuration will thus vary dependent on the driver used.

Supported drivers

The list of drivers supported by IGSS is continuously expanded. An up-to-date list is available
on the 7T Web Site. From the Drivers Available Now page, driver details such as hardware and
software requirements are available.

@ Managing drivers

Adding a new driver
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To add a new driver, click @ and select the relevant driver in the Select Communication
Driver dialogue.

Tip: Click the column header to sort the items in the list.

Select Communication Driver [ 2] |

Select a communication diver to be installed from the lizt
below, Then click OF.

Ciriver | 1] | D ezcription -

Q. Demolry 1 Simulation driver for demo purpoze only

L 7T 3964R Siemens zerial 3964r/1k512 interface driver
Q TT53964R Siemens 3964r/k51 2 driver uging SIC0S protocol
Q FTH1 Siemenz SIMEC H1 ethemet driver [uzing |50 transport]
Q FTSH1 Siemenz SIMEC H1 ethemet driver uzing SICOS protocal
Q FTLZFDL Siemenz SIMEC L2 driver uzing AG-AG protocol
Q FTSLZFDL Siemenz SIMEC L2 driver uzing 5IC0O5 protocal

Siemens 57 protocal driver

=) 7157

Q. TTTEX Texas Instruments tranzparent byte protocol driver
Q JTTPE 0 MK 795 Comli TPEOOD radio protocol driver
1

% TTABE General High protocol driver for ABB, 5+5 and Hitachi_ILI
4 3

] I Cancel |

— = WO 00 = O O = L0 Pl

Editing driver properties

When the driver is added, its name appears in the tree view pane and a humber of property
sheets appear to the right.

Three tabs are general to all driver types, whereas SICOS drivers require additional parameters
(see below).

Click on a tab for details.
Diriver Infarmation | Advanced I External Types

Special SICOS parameters

If you are using a SICOS driver, the General and Time Services tabs appear.

Click on a tab for details.

Diiver Information. General | Time Services .-’-'-.dvanu:edl External Typez



Driver Information tab

What it shows

On this tab, you can view the following information:

In this group ...

you see the following ...

Driver Information

The name of the selected driver and its
driver ID. The number of nodes and
subnodes defined for this driver.

File Versions

The filename and version of the Driver
DLL and the Configuration DLL.

How it looks

The figure below shows the Driver Information tab.

Configuration name: Demo

-3 16555erver_t

W Generic TCPJIP Driver

-8 Modicon Modbus protocal driver
T OPC (OLE For Process Contral) Client side
IG555erver _2

Pl

opz

Op3

OP4

OPS

1 ALY AR LI AED A e

Drriver Information l.ﬁ.dvanced External Types
Diriver Infarmation

M odicon Modbuz protocol driver

[Crriver 1d: 20)
Statiztics
Top Hodes:
Sub Hodes:
File Werzions
Diriveer DLL
File: FTMOD.DLL
Werzion; £.00.00 [build: 4267

W Configuration DLL

File: FTMODC.DLL
£.00.00 [build: 4267)

W ersian:
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Advanced tab

What it shows

On this tab, you can specify the following:

In this group ... you can specify ...

Activation Condition where the driver is activated. Typically, the
driver runs on the server, but if you are using dis-
tributed drivers, it can run on the operator sta-

tion.
Activation Interval How often you want to activate the driver.
Driver Messages per How many messages the driver must be able to
Channel handle concurrently.
Segment Length The max. length of a message segment sup-

ported by the PLC.

How it looks

The figure below shows the Advanced tab.



Configuration name: Demo Driver Information  Advanced | Euternal Types
-3 1G555erver_t
+- 8 Generic TCPJIP Driver Advanced Driver Settings
el IModicon Modbus protocal driver Activation Condition
+-H OPC (OLE For Process Contral) Client side . . o .
4.8 16555erver 2 % Specify the station bype where the driver ig activated.
®l opy v Server or zsingle user
= opz [ Suspend driver
=l ops
2} opd Activation |nterval
=l ops ctivation nterva
Decreaze thiz walue if the driver should be activated
g rnore often in order to handle large amounts of data,
Activation interval [miliseconds): 100 —
Diriver Meszages per Channel
S Specify the maximum number of messages the
driver should be able to handle concurrently:
Driver meszages per channel: 7 _%I
Segment Length
wminies  Specify the maximum length of a meszage
geament which iz supported by the PLC.
Segment length [words); @B
£ 2

External Types tab

What it shows

On this tab, you can enable or disable the relevant external types (PLC data types) for numer-
ical values and string values.

In most cases, the default choices will be relevant, but you can change them, if necessary.

The changes made on this tab are global to the selected driver. If the driver is part of
another configuration, the changes will also apply here.

External types

The external type is a central concept in IGSS. When you specify the external type as part of
the PLC address, IGSS knows how to interpret the incoming value from the PLC, so that a mean-
ingful value is shown during supervision.
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For details about the individual external types, click here.

The external type is selected as part of the PLC address on the Edit Mapping tab in the Def-
inition program as shown below. The drop-down list contains the external types which are ena-
bled in System Configuration (see figure below).

pl @ Global - Pump water EE |

Change State | BitMapl/0 | &laminféckBit | Command/State Config
Drata b anagement Definitions I Display ~ Edit Mapping | Fieport Format I Symbal Definition

—Atom — PLC Mode for object: pl
Command

Diivver : [7Ta5511 1655 _Severt) =]
Mode : IEI j

— PLC Addresz for Command atom:

Drata Group IED

[40 mode it -

‘wiord Offset : |1 |

— Alarrn D etails

||| Bitomset: o =]

Digital Alarms ; |<+1_ 205 j

Esternal Type: IFF'1 G j
wew | Edt | [ e |

IJze numernc +7- to zoroll to nest/previous atam

ak. I Cancel Help

How it looks

The figure below shows the External Types tab.
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Configuration narme: Demo

-3 1G555erver_t

W eneric TCPJIP Driver

bl rodicon Modbus protocal driver
W oPC (OLE For Process Contral) Client side
IG555erver _2

OP1

P2

OP3

OP4

OPS

(N AT AR I AED A e

Add and Manage Drivers

@ Add a new driver

Drriver Infarmation | Advanced External Types

External Data Types

11'3'3';'311? Select the external types to uze with thiz driver from the
115501 stat izt af available tpes below.
T

¥ Specity external data twpes for pumencal values
(" Specify external data tppes for string walues

[1BCD135 - 13 Bit Signed BCD word [16 bit)

[(JBCD1E - Binary Coded Decimal [16 bit]

[(JBCD32 - Binary Coded Decimal [32 bit]

[(JBCD32 - Binary Coded Decimal. Wardzwapped [32 bit]
[WCOUMTER - Counter [16 bit)

[JCOUMTER - Siemens Simatic Counter [16 bit]

[CIFLOAT - IEEE Floating Point [32 bit]

[CJFLOATSA - Floating Point. Saia Format [32 bit]
[CJFLOATWS - IEEE Flaating Paint. ‘Wardzwapped [32 hit]
[IFP1 - Dupline Single bit maszk [16 bit]

[JFP13=A2 - Special: 13 bit value with 2 alarm bitz [15 bit]
[w]FP1E - Sigrned “Wword [16 bit]

[w]FP1EL - Unzighed wWord [16 bit)

[JFP28 - Siemens Simatic 28 Bit Counter [32 bit)
[CJFP32EWS - Unzigned Double Word, ealy wordswapped [32 bit]
[JFP325 - Signed Double Ward [32 bit]

[CJFP325WS - Signed Double “Word. Wordswapped [32 bit)
[CIFP32U - Unsigned Double 'word [32 bit)

1. Select Edit > New Driver or click the icon above.
The Select Communication Driver dialogue appears.

To add a new driver, you can also right-click the station name and

select New Driver.

2. Double-click the driver you want to add. Sort the list by clicking a column header.




Result: The driver name is added to the tree view. If the driver only supports one interface
type, it is automatically added.

3. Edit the driver properties, as required.

4. When you have made the necessary changes, click the button below.

2| Add a new interface

Edit driver properties

1. Inthe tree view, select the driver whose properties you want to change.

2. Edit the properties, as required. For details about a property tab, click its name
below.

Changes made on the External Types tab are global to the selected driver.

Suspend a driver

In some special situations, you may want to suspend a driver. For example, if the process com-
ponents connected to its associated PLCs are being serviced, the values received by IGSS will
be erroneous. In that case, you can suspend the driver temporarily by following this procedure:

1. Right-click the driver you want to suspend.

2. Select Suspend driver.

Result: The driveris now suspended and will not collect data from its associated PLCs until you

select this menu item again. A red cross appears in the tree view clearly indicating that the
driver is suspended.



Profile: TestPrao
-2 PRR_vS
x Allen Bradley RaLiny inkerface driver

EaR0 [k 795 _omli TPEOOD radio protocol driver
-3 Siemens 57 protocal driver

E Remove a driver

1. In the tree view, select the driver you want to remove.

2. Select Edit > Remove or click the above icon.
A confirmation message appears.

3. Click Yes to remove the driver.

You can also right-click the interface and select Remove Driver.

Import and Export Driver Settings
Import/Export files (*.ixd)
All settings defined in System Configuration can be exported and imported. You can -
e Export driver settings from v2 to an export file (*.ixd)
e Export driver settings from the current version to an export file (*.ixd)
e Import driver settings into the current version from either of the two sources above
Export IGSS v2 driver settings
You can export the driver settings from the active v2 driver profile for the purpose of importing

those settings into the current version. This function will read the settings for the active driver
profile in the Windows Registry.

1. Select Tools —» Export IGSS V2 Driver Settings. The Save As dialog box
appears.

2. Give the export file a meaningful name, for example, MyDrvSetupv2.idx and click
Save.



3. To import these settings, open the relevant configuration and select Tools - Import
IGSS Driver Settings.

Export IGSS v8 driver settings

You can export the driver settings to a file for the purpose of importing those settings into
another configuration. The typical case is when you are configuring the drivers at your own
office and want to copy these settings onto the IGSS server at the plant.

1. Select Tools — Export IGSS v8 Driver Settings. The Save As dialog box
appears.
2. Give the export file a meaningful name, for example, MyDrvSetupv8.idx and click
Save.

3. To import these settings, open the relevant configuration in the System Con-

figuration program and select Tools —» Import IGSS Driver Settings.
Import IGSS driver settings

You can now import the driver settings saved in an IGSS driver file (*.idx) exported from either
v2 or the current version.

1. Open the relevant configuration in the System Configuration program.
Select Tools —» Import IGSS Driver Settings. The Open dialog box appears.
Find the relevant IGSS driver file (*.idx).

> W

Click Open. The settings are imported.

3.2 Interface Setup
Overview

@I Types of interfaces

Two main types of interfaces

A driver can use one of the two main interface types:

e Serial connection (COM port, modem or other scheduled connection)

o Driver-specific interface (proprietary interface card or standard network card)
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COM port connection

If the PLC and the PC are directly connected with a serial cable, select this option on the Con-
nection Type tab and configure the COM port on the Serial Port tab.

22

559 Modem connection
If the PLC and the PC are connected via a modem, select this option on the Connection Type
tab and configure the modem, as required.

Remember to set the special parameters for remote connections on the Remote tab.

Other scheduled connection connection

If the PLC and the PC are connected via another type of scheduled connection, select this
option on the Connection Type tab.

Configure the COM port on the Serial Port tab and remember to set the special parameters for
remote connections on the Remote tab.

Device-specific interface

Some drivers do not support any of the above serial connections, but only connections via
device-specific interface cards or standard network cards.

When you add such a driver, this icon “®* appears in the tree view. Dependent on the interface,
one or more property sheets are shown.

Refer to the manufacturer’'s documentation for further information.

@ Managing interfaces

@ Adding interfaces

To add a new interface, right-click the relevant driver and select New Interface in the popup
menu or click the above icon.

By default, a relevant interface is added, for example, a COM port represented as %ﬁ: in the tree
view.



To change the connection type, simply select another type on the Connection Type tab.

Editing interface properties

To edit interface properties, select the interface in the tree view, then edit the properties on the
tabs displayed.

For further information on the individual tabs, click here.
Deleting interfaces
To delete an interface, select it in the tree view, then click ﬂ

Connection Type tab

What it shows

When you select a serial connection in the tree view, this tab appears.

It allows you to select the connection type as follows:

Select this|if the PLC and PC are ...

option ...

=] directly connected via a serial cable.

%‘i\. connected via modem. Use the Configure Con-

i nection and Configure Modem buttons to configure
the modem.
connected via a other scheduled connection.

How it looks

The figure below shows the Connection Type tab.
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Configuration name: Demo Connection Type | Serial Port | Bemate
=8 15555erver_1

+- % Generic TCPYIP Driver Specify Type of Connection
S %:]di':':“" Modbus protocol driver {7 Connect directly via the zerial port
+ Maodem 0

¥ *8 OPC (OLE For Process Control) Cli = The PC and the PLC is directly connected via a serial cable.

[m] liil . . .
+ = [G555erver 2 I [Configure the zenal part on the tab: "Senal Port']

ml opy
ml ~pz
=) oP3 Scheduled Connection
=l opg . , _

— The PC will anly establizh a connection with the PLC at

QpPs predetermined times and/or with a fized time interval.
Nl

(%) The PC and the PLC are connected via a madem.

"‘%‘l} Select modern 1D:

" [k {3 The PC and the PLC are connected directly or via
equipment which does not require any special
cohnection handling [e.g. a radio moderm).

[Configure the zenal port on the tab: 'Serial Port')

[]Da naot cormect ivitially ta all nodes when driver iz started.

[ ]&larm modern. Only incoming calls, [(&dd one dummynode]

[]5uzpend interface

Serial Port tab

What it shows

When you select a serial connection in the tree view, this tab appears.

It allows you to select the relevant COM port and configure it as follows:

This dialog box |allows you to

item ...

Select com- select the rel-
munications evant COM port
port to which the PLC

is connected.




Serial Port Set-
tings

set the com-
munication
parameters for
the selected COM
port, as required.

Note: The
number of param-
eters that can be
changed depends
on the selected
driver.

How it looks

The figure below shows the Serial Port tab.

==l 15555erver_1

+

(ALY ACT ALY AC AL

IG555erver_2
QP
QP
81K
QP4
QPS5

Configuration narme: Cremo

+- B Generic TCPJIP Driver

- & Madicon Modbus protocol driver

+ %ﬁ] Modem 0

B OpC (OLE For Process Contral) Client si

Conmection Type | Senal Part | Remate

Senal Port Canfiguration

2

Senal Port Settings

Configure the senal port by selecting the proper zettings
below:

AREEE v

Select Communications port;

Set properties for the zenal port. Only propertiez which
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Baud Fate: 9600 b
Data Bits: a “
Stop Bits: 1 "
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Remote tab

What it shows

When you select a serial connection in the tree view, this tab appears.

It allows you to specify special parameters for remote connections (modem or other scheduled
connection):

In this group ... you must specify ...

E""EE a PLC address where IGSS can read the log-
] Handling of incom- |ical nhode number of the PLC. This ensures
ing calls that the data will be associated with the cor-

rect node number in IGSS.
/ a value at a specific PLC address where IGSS
Indication of Suc- can indicate that all data has been suc-
cessful Call Handling cessfully scanned (current and historical

values). IGSS will disconnect once this value
is written to the specified address.

How it looks

The figure below shows the Remote tab.



Configuration name: Demo Connection Type | Serial Port | Femate
=8 15555erver_1

+- % Generic TCPYIP Driver Handling the remode FLC
=% Modicon Modbus protocal driver

+ %ﬁ] 1. 4CoM1 Common station [0 used in 1 ~
+- % OPC (OLE For Process Control) Client si communication pratocal >
+-ml 15955erver 2
= COFl Handling of incoming calls fram the PLC
ml ~pz
ml ops
=1 op4 Fetch the IG5S Mode number from PLC
[

OP5 EEHEE When the PLC initiates a connection with the PC the

£

IGSS Mode number can be read by the PC at the
following location:

Drata Group / Meszage type: 1
whord Offset: 0

Indization of Succezsful Call Handling

Toindicate to the PLC that 1G55 has scanned all data
succezsfully a value iz writken in the PLC at the
following location before 1G55 dizconnects:

Drata Group / Meszage type: g
Wwiord Offzet: 0
Wirite this value when completed: 1|

By thiz the PLC can detect if the connection haz been
terminated prematurely.

Driver-specific tabs

Introduction

If your driver supports only one specific interface, it will be automatically added when you add
the driver. One or more property sheets will appear showing the specific parameters you can
set.

For further information about the individual properties, refer to the manufacturer’s doc-
umentation.

Example: Profibus FMS protocol driver interface

The figure below shows the Device Settings tab for the above interface.



Configuration name: Demno
=8 15555erver_1
+- % Generic TCPYIP Driver
+- % Modicon Modbus protocal driver
+- % OPC (OLE For Process Control) Client si
- % Profibus FMS protocal driver
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Add and Manage Interfaces

@I Add a new interface

Device Setlings

Prafibuz bus parameters:

Specify bus parameters for the Profiboard

Local Station Addreszs [1.. HS5A)]

Baudrate:
Bus Parameters:

Highest Station Address [HSA):
Tslat:

bir. Tadr:

Maw. Tedr

T quiet:

T zetup:

TTR:

[3ap factor:

kA aw. retr limit:

1. In the tree view, select the driver to which you want to add an interface.

10 =

187.5 kbps »

10

4

400
20

360

a0
10000
1

1

Set Defaulkz

If the selected driver only supports one interface type, it is already shown in the tree

view.



2. Select Edit > New Interface or click the above icon.

3. Click the interface you want to use:

=] Direct connection (COM port)

=IModem connection

2] Other scheduled connection

| Driver-specific interface

Edit interface properties

1. In the tree view, select the interface whose properties you want to change.

2. Edit the properties, as required. For details about a tab, click its name below.

Suspend an interface

In some special situations, you may want to suspend an interface of a driver. For example, if
you have a dial-up connection and the modem is not currently working or being serviced. You
can suspend the interface as follows:

1. Right-click the relevant driver.

2. Select Suspend interface.

Result: The interface is now suspended and will not collect data from its associated PLCs until
you select this menu item again. The interface will be clearly marked with a red cross to indi-
cate the suspended mode.
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E Remove an interface

1. Inthe tree view, select the interface you want to remove.

2. Select Edit - Remove or click the above icon.
A confirmation message appears.

3. Click Yes to remove the interface.

You can also right-click the interface and select Remove Device.

3.3 Node Setup

Overview

What is a node in IGSS ?

Definition
A node represents a physical control device in the process (typically a PLC). Each node has a
logical node number that is used by IGSS to identify the PLC.

When IGSS knows this number, it can associate the correct process values with the cor-
responding process components (which are connected to the PLC).

Example: An IGSS network

The figure below shows a simple IGSS network with a server, two operator stations and three
PLCs (nodes). Each node has a logical node number that identifies it in the system - the IGSS
node number.



T

Cperator stations

FLCs (nodes)

Frocess @ - G55 Server
J— AN

Identifying the node

When you define a process component in the Definition program, you must indicate which PLC
(node) it is connected to. This is done on the Edit Mapping tab of the object properties dialog
box. Open the dialog box by double-clicking the symbol representing the process component.

For further details click here.

Managing nodes

@l Adding nodes

To add a node, right-click the relevant interface in the tree view and select New Node or click
the above icon in the toolbar.

A default node number is added which you can change on the Node Properties tab.

Profile: Carlsberg {active Profile)
I__—_IQ IgssServer
= % |Bosch Biiep12/Bilepl € protocol dr
- = COML:
b
: %ﬁ] Modern 0
W Siemens 57 protocol driver

] op1
- opz

()
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Editing node properties

To edit node properties, select the relevant node in the tree view, then edit the properties on
the tabs displayed. The number of tabs depend on the driver you use, the interface con-
figuration, etc. The table below shows the tabs displayed for different configurations. Click a tab
for further information.

Note: Apart from the tabs below, driver-specific tabs may also appear.

For this these tabs appear ...
type of
interface...

Direct con- Mode properties  Advanced |
nection via
COM port

Scheduled Mode properties  Remate Connection | Caonnection Mizc. | Advanced
connection
(for exam-
ple, modem
or radio link)

SICOS Mode properties | S|COS parameters
driver

E Deleting nodes

To delete a node, select it in the tree view, then click the icon in the toolbar.

Node Properties tab

What it shows

When you select a node in the tree view, this tab appears. The properties displayed are driver-
specific, but the following properties are always displayed:

This property ... allows you to ...

IGSS node number specify the logical node number of
the PLC. This is the node number
you select in Definition when you
define a process component (IGSS
object).

Telegram Retries adjust the number of times you




want the driver to retry sending of
telegrams to the node. The default
setting is 3.

How it looks

The figure below shows the Node Properties tab for the Siemens AS511 interface driver.

Profile: Carlsherg

= 1555_Server1

[+ # Allen Bradley RSLinx interface driver

W MK 795 Comli TPE00D radio protocal driver
=% Siemens AS511 interface driver

= oM

- H Siemens 57 protocol driver

- H Siemens SIMEC L2 driver using SICOS protocal
oP1

opz2

OP3

Advanced tab - Overview

What it shows

MNode Properties | Advanced I

— Connection Properties:

T

Specify 1G55 node number and CPU pe for this node.

G55 node number: I ] - I

Thiz node haz a Simatic 9236 CPL: r

— Protocol Properties:

5 Increaze telegram retries if driver generates frequent
ﬁ?= communication alarms. Maormally, 3 teleagram retries are

zufficient,
Telegram retries: 3 ::II Set Default I

When you select a node in the tree view, this tab appears (except for SICOS drivers).

It includes four subtabs that allow you to send special telegrams to and from the selected node
(PLC). Together, these telegrams are called extended services. They include system start, time

synchronisation and keep alive telegrams.




Note: To use all the extended services, you must enable the mailbox and specify its location and size
within the PLC where IGSS can post the special telegrams.

How it looks

The figure below shows the four tabs. Click on any of them for further information.

b ailbox I Syztem Eventz I Time Services  Feep Alive Services
Advanced - Mailbox tab

What it shows

When you select a node in the tree view, this subtab appears on the Advanced tab (except for
SICOS drivers).

The following properties are available:

This property ... allows you to ...

Enable mailbox enable the mailbox.

Note: You must enable the mailbox to
use all the extended services and to
define subnodes.

PLC address specify the exact PLC address where the
special telegrams (extended services)
should be written to.

Mailbox length specify the number of words allocated
for the special telegrams. The required
number of words depends on how many
telegrams you use and their data for-
mat. In most cases, 20 words will be suf/{
ficient.

How it looks

The figure below shows the Mailbox tab.
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v Set M ailbow Add thiz Mod
+- %2 Siemens 57 PC adapker inkerface driver Ellip a Malbox 855 In this Hode
+-B 1essserver 2 | order to uze extended services a mailbox
mi ey % lozatian in the PLC must be specified az an address
E range. The PC will zend all zpecial telegrams ta the
=l opz ;
railbox.
=l op3
D atagroup for mailbos; 0 El:
Start offzet for mailbox: 4 El:
b ailbox length [in WORDS]: 20 =
£ >
For Help, press F1 MLIM

Advanced - System Events tab

What it shows

When you select a node in the tree view, this subtab appears on the Advanced tab (except for
SICOS drivers).

The following properties are available:



lote: You must enable the mailbox on the Mailbox tab in order to use system event tel-

grams.

In this group ...

you can ...

Telegram format

System Start Noti-
fication

enable the system start telegram which is
sent to the PLC when the IGSS configuration
is started (DC).

For details on the system
start telegram, click here.

Alarm Change
Notification

enable the alarm change telegram and spec-
ify the min. and max. alarm priorities to be
reported. The telegram is sent if the alarm
count changes in the running IGSS con-
figuration.

Two preconditions must be met, before the
telegram is sent:

e The alarm priority must be within the
specified min. and max. range.

e The To PLC option must be selected for
the alarm text in question. This is done
in the Edit Alarm Description dialog box
in Definition.

For details on the alarm
change telegram, click
here.

How it looks

The figure below shows the System Events tab.
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-8Bl 16555erver_1
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Systern Start Nobificat
+- % Siemens 57 PC adapter interface driver BRI D LSS
+- 8l 15555erver_2 L] Check. this ophion to zend a system start
ml opy telearam ta the PLC duning system startup
i op2 [requires a mailbox).
=) o3 W Send system start telegram during spstem startup.
Alarm Change Motification
= Check thiz option to 2end an alarm change
telegram to the PLC when the spstem alarm
count changes [requires a mailbos).
[v Send Alarm Change Telegram
Minimum alarm priority bo be sent 1] 3:
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£ >
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Advanced - Time Services tab

What it shows

When you select a node in the tree view, this subtab appears on the Advanced tab (except for
SICOS drivers).

The following properties are available:



In this group ...

you can ...

Telegram format

Send/Receive Time Syn-
chronisation Telegrams

enable the time synchronisation
telegram and choose whether
the node is the time slave or
master.

For details on the time syn-
chronisation telegram, click
here.

Time Stamp

include a time stamp in all tel-
egram headers sent from the
PC to the PLC

For details on the time stamp
telegram, click here.

Use UTC! for Time
Stamps

enable the universal time for-
mat, UTC or use local time.

How it looks

The figure below shows the Time Services tab.

luniversal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating
time in most parts of the world. IGSS uses this time format internally in the database. You can
switch between UTC and local time by enabling or disabling the "UTC" field in various dialog

boxes in the system.
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Configuration name: Demo

Mode F'rl:uperties] Fiemaote I:l:unnectil:un] Connection Misc,  Advanced l
-8l 16555erver_1

- % General Comli 51 protocal driver Advanced Mode Properties
= %:ﬂ Modem O . .
Mode 0 M ailbo ] System Events  Time Services l F.eep Alive Services ]

+- @ OPC (OLE For Process Contral) Client side . . -
v Send/R Time 5 tian Tel
+- 8 Siemens 57 PC adapter inkerface driver - ST = LT TIRERent | =i=giEms
+- =l 15555erver_2 " Thiz PLC node iz Time M aster
=l opy
= ez * Thiz PLC node iz a Time Slave
]

P — Specify how often time synchronization
telegrams zhould be zend ta the node's mailbos

Time interval [minutes]; 2 El:

Time Stamp in Telearam Headers

Check thiz option ta include time stamp packets in
all telegram headers zend from the PC to the PLC.

v Include time stamp packet in telegram header

Iz UTC far Time Stamps

[ Use UTC [Coordinated Time Farmat) for aII
g@ timestamped telegrams. :

£ >

For Help, press F1 MWLM

Advanced - Keep Alive Services tab

What it shows

When you select a node in the tree view, this subtab appears on the Advanced tab (except for
SICOS drivers).

The following properties are available:

This property ... allows you to ... Telegram format

Keep Alive PC > PLC send keep alive telegrams For details on the keep
from IGSS to the PLC with a alive telegram, click
fixed interval. here.

Keep Alive PLC > PC send keep alive telegrams For details on the keep
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from the PLC to IGSS with a alive telegram, click
fixed interval. here.

If the keep alive interval times out, alarm no. 46 “"No heartbeat received” will occur in the alarm

list.

Note: The Driver object which is included in every IGSS configuration you create mon-
itors the communication at the driver level between the PLC and IGSS. The keep alive
function monitors the communication at the node level.

How it looks

The figure below shows the Keep Alive Services tab.

Configuration name: Cemo
-8Bl 16555erver_1
- General Comli 31 protocal driver

= %ﬁ] Modem 0
Mode O

W OPC (OLE For Process Contral) Client side
B siemens 57 PC adapter interface driver
1G555erver_2

OFP1

Pz

Op3

QERACTHEN A IgEaRee

£ »
Far Help, press F1

Mode F'ru:uperties] Remate Eu:unneu:tiu:un] Connection Mise.  Advanced l
Advanced Mode Properties
bzl ] Systern Events ] Time Services  Keep Alive Services l

[+ FKeep &live PC > PLC

i Enter the timeintersal which should elapse
between Keep Alive telegrams are send from

the PC to the PLC [requirez a mailboz].

Time interval [minutes]; 2 =

v Eeep dlive PLC - PC

- Enter the tirmeinteryal within which the PC iz

% expected to receive Keep Alive telearams from
the PLC. A communication alarm will be
generated if no K.eep Alive packets are
receied.

Time interval [minutes]; | :

UM
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Remote Connection tab (remote only)

What it shows

When you select a node in the tree view which is reached via a remote connection (modem or
other scheduled connection), this tab appears.

The following properties are available:

This property ... allows you to ...

Phone number type the phone number of the PLC you want to connect to.

Connect at specific points in connect to the PLC at specific times.

time Click Edit to define the times.

Connect at fixed time inter- connect to the PLC with a fixed time interval (given in minutes).

vals

Connection hold time specify the time you want to hold the remote connection open when
the operator goes manually online or sends a command to the
remote PLC.

How it looks

The figure below shows the Remote Connection tab.
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Mode Properties

Remaote Connection | Connection Mize, || Advanced

Configure Remaote Connection to Mode

Specify parameters to be uged to connect remotely to
the PLC node.

Enter the phone number: Enter extra AT commands:

45333742

Connection Scheduling

Specify when the PC should connect ta the PLC for
retrieval of higtorical data:

Connect at gpecific points in time

Connect at theze times:

02:00, 08:00, 14:00, 22:00

[ Connect at fised time intervals

Time interval between connections [minutez):

Connection hold time

Spefify how long time the connection should stay open for bath
connection types:

Marmal connect hold time [zeconds]: 300 -
Send cmd connect hold time [zeconds]: 30 :
MM

Connection Misc. tab (remote only)

What it shows

When you select a node in the tree view which is reached via a remote connection (modem or

other scheduled connection), this tab appears.

The following properties are available:

In this group ...

you can ...

Collecting Historical Data

configure where you want IGSS to collect historical
data. Click Configure to make the definitions.

Connection Status and Control

specify the PLC address for a digital object in your




IGSS configuration that shows you the connection
status. The object is created in Definition.

Click here 2l to learn how.

Callback to Node

make IGSS perform a callback to the node when the
latter makes an unsolicited connection with the PC.

Note

In most cases, you will not enable this option,
because it means that it will take longer to get the
data that the node was trying to deliver to IGSS. But
in some cases, the driver may require that you do
it.

How it looks

The figure below shows the Connection Misc tab.
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Collecting Hiztancal Data

YWhenever |55 connects to the node, it will read historical
data values accumulated by the node zince it was last
connected.

[Currently exists 6 histarical data definitions for this node]

Settings...

Connection Statuz and Control

The remote connection can be monitored and controlled by
connecting an G55 object to a specific address.

[v Monitor and control connection

Address uzed for connection status and cantral Faor
thiz node:

Data Group / Meszage type: n
word Offzet; q

Calback to Mode

m [ Select this option if 1G55 should perform a callback to the
node whenever the node establizhes an unsolicited
t connection with the PC.

Far Help, press F1

MM

Add and Manage Nodes

@l Add a new node

1. Inthe tree view, select the interface to which you want to add a node.

2. In some cases, the node is automatically added with the interface. In that case, skip

the next step.

3. Select Edit - New Node or click the above icon in the toolbar.
A new node number and icon appears in the tree view.

4. Edit the node properties, as required.




5. If you want to add a subnode, click the button below.

2]Add a new subnode

If you want to add subnodes and use the extended services, you must enable the mailbox
on the Advanced tab (SICOS drivers excepted).

Edit node properties

1. In the tree view, select the node whose properties you want to change.

2. Edit the node properties, as required. For details about a tab, click its name below.

If you want to add subnodes and use the extended services, you must enable the mailbox
on the Advanced tab (SICOS drivers excepted).

Suspend a node

In some situations, you may want to suspend a node. For example, if the process components
that are connected to a certain PLC are being serviced and thus provide erroneous values to
IGSS. You can suspend the node as follows:

1. Right-click the node you want to suspend.

2. Select Suspend node.

The node is now suspended and will not collect data from its asso-
ciated process components until you select this menu item again.
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Profile: TestPro
==, PFR_vs

=3 allen Bradley RSLinx inkerface driver
-« TTAB

I Mode 1

- 3 MK 795 Comli TRAO0D radio protacal driver
-3 Siemens 57 protocal driver

If you suspend a manager node, all its associated subnodes will also be suspended
because IGSS only communicates with the manager node.

E Remove a node

1. Inthe tree view, select the node you want to remove.

2. Select Edit > Remove or click the above icon in the toolbar.
A confirmation message appears.

3. Click Yes to remove the node.

You can also right-click the node and select Remove Node.

Collecting Historical Data from a Remote PLC

Collecting historical data from a remote PLC

Introduction

In some IGSS installations remote PLCs will collect process data. A typical example could be
remote pump stations for a wastewater treatment plant.

These PLCs are not online all the time, but are automatically dialed up with a fixed interval (for
example, twice a day). The dial up schedule is set up on the Remote Connection tab. Also
the operator can manually dial up the remote PLC.

During the offline period, the remote PLC will store process values with a given interval. Some
PLCs will even support storing of events (only changes in process values are stored). This is
what we call historical data. The historical data can be collected by IGSS when the remote PLC
is online by following the procedure below.



To allow the operator to create graphs and reports for the monitored objects, the historical data
must be saved in the IGSS log files and the .bcl files.

Example

To illustrate the functionality, we will make an example based on the IGSS Demo Configuration.
We will go through the following steps:

1. In System Configuration add the remote PLC using the General Comli
31 protocol driver.

In System Configuration, define the Historical Data Settings.

In Definition, create the object that collects historical data.

In Definition, create a graph that shows the historical data.

v A W N

In Supervise, show the graph.

3.4 Subnode Setup

Overview

What is a subnode ?

Definition

A subnode is a node (PLC) which communicates with IGSS through a gateway node (the man-
ager node).

Manager node and subnode

All communication between a subnode and IGSS is routed via the manager node which is there-
fore the communication gateway for IGSS as shown below.
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Ethernet. Token Ring ar other network,

~—

G55 server

<:i PLC network

il i Nodes

banager node

EHEEE subnodes

Preconditions

To define a subnode, the following preconditions must be met:

e The PLC program in the manager node must be written to support subnodes

e The mailbox must be enabled for the manager node. The mailbox is an address area on
the manager node reserved for communication with the subnode.

All SICOS drivers support subnodes and do not require a mailbox.
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Managing subnodes

EI Adding subnodes

To add a subnode, right-click the relevant manager node in the tree view, then select New
Subnode in the menu or click the above icon.

A default subnode number is added which you can change on the Subnode Properties tab.

Configuration name: Cremmo
== 15555erver_1

-8 General Comli 31 protocol driver
= %ﬁ] Modem 0

- Mode 0

s JSubhode 1

W OPC (CLE For Process Contral) Client side driver
W Siemens 57 PC adapter interface driver
IG555etrver_2
QR
Op:2
OP3

(CAACY AT AL

Editing subnode properties

To edit subnode properties, select the relevant subnode in the tree view, then edit the prop-
erties on the Subnode Properties tab. Click the tab below for details.

| Subnode Properties

For a SICOS driver, the properties are a bit different. Click the tab below for details.

| Subnode Properties

E Deleting subnodes

To delete a subnode, select it in the tree view, then click the icon above.

Subnode Properties tab

What it shows

When you select a subnode in the tree view, this tab appears.

The following properties are available:

This property ... allows you to ...
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IGSS subnode define the node number for the PLC - the one you address
number in Definition.

Keep Alive PLC > enable keep alive telegrams from the subnode to IGSS and
PC define the appropriate interval.

If the keep alive interval times out, alarm no. 46 "No heartbeat received” will occur in the alarm
list.

Note: The Driver object, which is predefined in a new IGSS configuration, monitors the com-
munication at the driver level between the PLC and IGSS.
The keep alive function monitors the communication at the node level.

For details about a property, click El, then click the item.

How it looks

The figure below shows the Subnode Properties tab.



Prafile: Carlsberg (Active Profile)
EQ IgssServer

i Subnode Properties I

El E Eosch Biiep19)Blep19E protocal di — Subnode Mumber
' %ﬁ] CoM1: Enter a node number for thiz subnode.
E%:ﬂ Modem 2 EHEEE All cormrandz zent to thiz subnode will be pozted to the
=] Mode 2 mailbas in the manager node. The manager nods i

rezpanzible for rauting cammands an ta the subnode.

E—

SubMode 3

W Siemens 57 protacal driver

- opy G55 subnode numnber:
- opz

—V Keep Alive PLC -> PC
Rir

Time interval [minutes): ]

Enter the timeinterval within which the PC iz
expected to receive K.eep Alive telegrams from the
PLC. & communication alarm will be generated if Ao
K.eep Alive packets are received.

=

4| [

Add and Manage Subnodes

EI Add a new subnode

To be able to add a subnode, the mailbox must be enabled for the manager node on the

Advanced tab (SICOS drivers excepted). All communication with the subnode is handled
by the manager node.

1. In the tree view, select the node (manager node) to which you want to add a sub-
node.
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Select Edit > New Subnode or click the above icon in the toolbar. A new subnode
number and icon appear in the tree view.

2. Edit the subnode properties, as required.

Edit subnode properties

1. In the tree view, select the subnode whose properties you want to change.

2. Edit the subnode properties, as required.

E Remove a subnode

1. In the tree view, select the subnode you want to remove.

2. Select Edit - Remove or click the above icon in the toolbar.
A confirmation message appears.

3. Click Yes to remove the subnode.

You can also right-click the subnode and select Remove Subnode.



Chapter 4: Monitoring and Controlling the Communication
Status

4.1 The Driver object

Definition

In every configuration you create, a standard system object called Driver exists. It provides
information about the driver: Whether the driver is running and whether communication to the
PLC(s) is possible as well as communication alarms.

The Driver object monitors the communication at the driver level, so if you have several
nodes defined for a driver, it is recommended to create a status object for each node.
Click See Also for details.

Communication alarms

The alarm numbers between 10 and 51 are reserved for various communication errors (the com-
munication ports, the PLC, the data collection engine, etc.). These alarms are automatically
reported in the alarm list, if communication errors occur.

Alarm numbers ... are used when ...

10 and 11 the setup of drivers is erroneous.

20 and 21 the communications ports are faulty.

30to 39 the extended event-driven communication drivers fail;
please refer to driver documentation.

40 a general PLC error occurs; please refer to PLC doc-
umentation.

41 to 45 there are driver communication errors; please refer to

driver documentation.

46 the connection to the PLC program is missing; the phys-
ical connection may be in order, but for some reason the
PC has not received the expected “I'm alive” message.

47 the extended event-driven communication drivers fail;
please refer to driver documentation.

48 there is an interface error to a remote driver.

49 there is an interface error to the Alarmnet.

50 incomprehensible data from the PLC is received by the

data collection engine (DC).

51 too much data output is generated, for example, if a DDE




Alarm numbers ... are used when ...

link generates too much data.

Handling driver alarms

During supervision, possible communication alarms will appear in the alarm list and can be han-
dled as any other alarm (acknowledged, etc.).

Displaying the Driver object

The Driver object may be shown on a process diagram to easily view its status. If any of the
alarms from the table above occur, the symbol representing the object will blink with the alarm
colour defined for the alarm text. To view the alarm text definitions, select Edit > Alarm
Texts, select the relevant alarm text and click Edit.

The figure below shows an example of how you can represent the Driver object using a *.bmp
file. The object has two states:
e < -1 when the driveris running

e < - 0 when the driveris not running

Driver

..........

4.2 The node status object

Purpose

To monitor the communication status of the individual node, we recommend that you create a
node status object. You can then reserve one or more process diagrams for an overview of your
PLC network where you can view the status of each PLC in the system at a glance.

How to create a node status object

The node status object is created as an analog object in Definition. Click here 2 for details.

Example: PLC network with node status objects

The figure below shows a PLC network where each PLC icon has been connected to a node
status object. An alarm text has been attached to the object to make communication alarms vis-
ible in the Alarm List.



If the communication fails with a PLC, its icon will blink and the communication alarm will occur
as an error code in the Value field of the Alarm List.

Note: The value 0 means that there are no communication errors.

7 {Global} PLC Network =]

Dperator stations I"

FLCs {(nodes)

- IGSS Server

Node.0.1.00 0 Node.0.1.1 0 Node.D.1.2 0
SUSPEND 0 SUSPEND 0 SUSPEND O

[ArALOG |[Glabal [susPEMD [ | Motmal = 0 s

1.1 Monitoring and controlling the remote connection status

In the Definition program, it is recommended to create a status object for each remote PLC
defined in System Configuration. This is done by creating a digital object for each remote
connection with a PLC address that matches the one defined on the Connection Misc tab for
the remote connection.

Important: The DIALUP template is built into every new configuration you create. So, if you've
created the configuration from scratch in version 5 or higher, you can skip this first part of the
procedure to start creating the status object immediately. If the configuration was created in a
previous version of IGSS, follow the procedure to create the template first.



1. Open Definition and create a digital template called DIALUP.

2. Inthetemplate properties dialog box, click the Bit Map I/0 tab and set the state bits (7) and command
bits (2) as shown below. Remember to check the States and Commands boxes under Single Bits.

DIALUP @ Global - DialupControl el 4
Statez and Commandz | D ata kanagement Definitions I E dit M apping I Symbal D efinition
Bit Map 1/0 | Alarm Indtck Bit I Command/State Config
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S I I R N (R s Singls Bits
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[T Displays
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Commarnd: =

Logic: 111 i pmnm 11111

LEGEMD:
- : State or Cornrnand bit
. Unaszighed bit
1 : One bit Logic &ctive
0 : Zero bit Logic Active

0k, I Cancel Help




3. Click the States and Commands tab to define these state and command names (bit
number in brackets):

e States: Invalid (0), Disconnected (1), Connecting (2), Historical scan (3), Normal scan (4), Dis-
connecting (5), Error (not used) (6), Send command (7).

e Commands: Connect (0), Disconnect (1) and Fetch historical data (2).

DIALUP - DialupControl el |
Bit Map 1/0 | Alarm Inddck Bit | Command/State Config
States and Commands | D ata Management Definitions I Edit Mapping I Syrnbal D efirition
State

IMWALID i’ | fidd State | | =]

Dizconnected
Connecting
Historical scan LI

[Telete |
Command
Connect Add I:n:nmmandl I j

Dizconnect
Fetch higtancal data

ak. I Cancel Help




4, Click the Command/State Config tab to enable the relevant command(s) for each
state. Select each state and enable the relevant command(s). For example, for the
Disconnected state, enable the Connect command.

DIALUP - DialupControl ed B3

Statez and Commandz I D ata kanagement Definitions I Edit M apping | Symbal D efinition |

Bit Map 140 | &larmn Indéck Bit Command/State Config
States Commandz
INVALID [w] Connect

Dizconnected
Connecting
Higtarical scan
Marmal zcan
Disconnecting
Errar [hot uzed]
Send command

[1Dizconnect
W Fctch historical data

Default Command

Connect j

0k, I Cancel Help

5. On the Data Management Definitions tab, make sure that scanning, logging and
data reduction are disabled.



DIALUP - DialupControl el 4

Bit Map 140 | Alarm Indéck Bit | Cammand/State Canfig
Statez and Commands D ata Management Definitions | E dit Mapping I Swmbal Defitition
— Scan interval — Logaing

2000 £ 10000 " &l changes 2%
L [ 5%
" 5000 30000 i paone s 0
. [ Log outgoing commands
& Mone Ir millizecs. ™ Logto SOL Database
—Baze interval——— — Data reduction—————— 1 Transfer to histony
[laverage ' Feduced value
2 10 [CItinirninm
. ) Actual total value
It awirnuim
5 a0 []5um " |dealized tatal value
[CJéctual = Mane
i* Mone  Inminz [1Change - -
: or each data
[Difference reduction method
[ Log to printer dlarm delay [T 0 zecs
Pratection Scale az Connect ta
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— =zer defined entries for command menu
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IJze zemicolon [;] to delimit multiple commands

Prefis [m«x=] to display x=x in the command menu othensize test up till first space iz uzed
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0k, I Cancel Help

6. Click the Edit Mapping tab to define the relevant driver and node number for the
State and Command atoms. We do not specify the full PLC address in the tem-
plate, this is done for the individual status objects.

Result: The template is now ready for use. Click OK to save it.
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DIALUP @ Global - DialupControl el 4
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Note

No alarm bits are defined for this template and it is recommended to use a command field to dis-
play the status object on the process diagram. Therefore, you need not select a symbol on the
Symbol Definition tab.

The next step is to create the status object:



1. Right-click at the position where you want the object and select New —» Command Field. This is the
recommended way of showing the status object. The Object Browser dialog box appears.

2. Click the + sign beside the area in which you want to create the status object.

3. Click the + sign beside Digital to show all digital templates and objects.

4. Select the DIALUP template.

5. At the bottom of the dialog box in the Create new object area, type the name of the status object. In

this example, we've used DialNode10.

Object Browser {Locked by <Create object from menuz=}
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5. Click Create. The properties dialog box for the status object appears with all the predefined properties
from the DIALUP template.

6. Click the Edit Mapping tab to define the PLC addresses for the State and Command atoms.
Tip: The PLC address for the State and Command atoms must match the address defined on

the Connection Misc tab in System Configuration. It is recommended to set the Data
Group and Word Offset to "0” to collect this type of status objects in this address range.

DIALUP @ Global - DialupControl el 4
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7. Click the Set Command Layout tab to configure the command field as shown below. The status object
is now ready to be placed on the process diagram.

DialNodeln |

Change State | BitMapl/0 |  &lamin/tck Bt |  Command/State Config |
D ata ManagementDefinitinnsI Displa_l,ll EditMappingI Feport Format  Set Command Layaout

¥ Show Command —Align
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[T Show State * Horizantal
Dlconnect
W Shadow ) ;
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Pattern Center v |-| 14
- R I 3
I J o Width IEEI
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Text Colaor
Height IEEI
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8. Click OK. The command field and the object name and description now appear.

9. Resize the field and place the name and description, as required. See example below.



Example

of Pump Station

DialModeld  Connecting Pump 1 Pump 2
Felease Felease
Connect

Faorce start Faorce start

Disconnect Felease Felease
Force stop Force stap

Fetch historical data
|___Reset | |  Reset |

Result: When you start the IGSS configuration, the current status of the remote connection will

be shown and the operator can conn
mand buttons.

Tips
e To define more status objects,

e For nodes that are directly con

ect, disconnect and fetch historical data using the com-

simply repeat the above procedure.

nected via a serial port, you can create a node status

object in the Definition program. Click here 2| for details.

4.3 Suspending a remote c

Purpose

If a remote PLC is being serviced, th
In that case, the operator may want

The DIALSUSPEND template

For that purpose, a template is inclu

onnection from Supervise

e operator will get communication alarms in the Alarm List.
to temporarily suspend the communication.

ded in every new IGSS configuration. The template is

called DIALSUSPEND. By using this template, the operator has access to two additional com-

mands compared to the DIALUP tem

The template includes the following

plate: Suspend and Resume.

states and commands:

States

Commands

Invalid

Connect (For internal
use)




Disconnected |Disconnect

Connecting Fetch historical data

Historical scan|Connect

Normal scan |Suspend

Disconnecting |Resume

Error 6-> (For internal
use)

Send com- 7-> (For internal

mand use)

Suspended

Create the suspend / resume object

In the following procedure, 7T recommends that you create two separate displays for this
object. One for the normal commands: Connect, Disconnect and Fetch historical data and
two buttons from which the operator can suspend and resume the remote connection.

Create the command field

1. In the Definition program, right-click at the diagram where you want to place the
object.

Select New - Command Field. The Object Browser dialog box appears.
Click the + sign beside the relevant area of the configuration.

Click the + sign beside Digital and select the DIALSUSPEND template.

i & WN

At the bottom of the dialog box in the Create new object area, type the relevant
name of the object, for example, DialNodeO.
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6. Click the Create button. The object properties dialog box appears.

7. On the Edit Mapping tab, do the following for both State and Command:

o Select the relevant driver and node number for the remote connection.

« Inthe Data Group and Word Offset fields, type the exact addresses specified on the
Connection Misc tab for the node. It is recommended to set the Data Group and Word
Offset to “"0” to collect this type of status objects in this address range.
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8. Click the Set Command Layout tab and do the following:
« Inthe Rows and # Cmds fields, type 3 to match the number of commands to display.
e Click the Show command and Shadow check boxes.

o Under Align, select Horizontal and click OK.

9. Place and resize the command field, the object name and state, as required.



DialNodeD

DISCONNECT

FETCH HISTORICAL

CONNECT

INVALID

e The operator will now be able to connect, disconnect and fetch historical data from the
Supervise program.

Create the Suspend button

1. Right-click where you want to place the Suspend button. It is recommended to
place it beside the command field we just created.

2. Select New — Standard Descriptors — Button Control. The Object Browser
dialog box appears.

3. Click the + sign beside the relevant area of the configuration.
4, Click the + sign beside Digital and select the DIALSUSPEND template.

5. Click the name of the object we created in the previous procedure and click the
Create button.
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2. Double-click the button to change its properties.

3. Click the Display tab and clear the Enable check boxes under Name and State /

value.

4. Click the Attributes of Button tab and do the following:

o Double-click the Bind command on click setting to enable it.

o Double-click the Suspend setting to make the button send that command.

o Under Style, double-click the Font property and make the text bold.




o Under Style, double-click the Text color property and select the red color to illustrate
the suspend command.

5. Click OK twice to close the dialog box.

6. Position and resize the button.

Create the Resume button

Right-click the button we just created and select Copy.
Right-click again and select Paste —» As Reference.
Drag the button down below the first button.
Double-click the new button to change its properties.

Click the Attributes of Button tab.

o v r W N =

Under Command on click, double-click the Resume setting to make the button
send that command.

7. Under Style, double-click the Text color and choose a green color to illustrate the
resume command.

8. Click OK twice to close the dialog box.

The final result should now look like this:

DialNode 0

DISCONNECT SUSPEND

FETCH HISTORICAL

RESUME

CONNECT

INVALID




4.4 Communication alarms

On the Data Collection tab there are settings for controlling how to display communication
alarms in the Alarm list. There are 2 sets of settings as represented by the two groups at the
bottom of the tab, the Alarms to Driver object and the Alarms to Node Status object
groups.

Alarms to Driver object
There are two settings from which to choose. These are:
e Only if no Node Status object defined or if node number unknown
Select this option if Node Status objects have been created for some of, or all, nodes in the
system. Alarms not related to a specific node will still be shown on the Driver object in the
Alarm list and will be given the node number 1026.
¢ To use this setting in a meaningful way, the Node Status object must have been
created and attached to nodes in the system For more information on the Node
Status object, click here

e Always

Selecting this option assumes that no Node Status objects have been used in the system;
driver alarms will be displayed

Alarms to Node Status object

e Only Node Status (High Alarm) alarms
Selecting this option displays only Node Status alarms on Node Status objects.
o Both Node Status (High Alarm) alarms and Driver object alarms

Selecting this option displays both Node Status alarms and Driver alarms on the Node
Status object.

¢ To use these settings in a meaningful way, the Node Status object must have been
created and attached to nodes in the system For more information on the Node
Status object, click here

There are two additional benefits worth noting when using the Node Status object. These
are:
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1. Alarm delay can be defined for the Node Status object.

2. A quick and reliable overview of node status can be presented graphically in the sys-
tem as a mimic.



Chapter 5: Tuning and Optimizing Data Communication

5.1 Communication efficiency information — [MyConfig].prt

The installation report [MyConfig].prt

When you install an IGSS configuration, you get the option of viewing an installation report.
You determine what you want to view in the report in the Installation Options dialogue
shown below.

Installation Options

|nztallation zettings |nztallation report settings
[] Do net report enmors on missing pictures Sort objects by PLC addresz
[ 1D not repart driver setup emnars []5ert objects by alarm number
[ Do MOT install - show only repart [ 5ot objects by object ype
Include these object types [] Show detailed ohject information
[ Skip this dialag ok || cancel | | Hep

PLC-related information

The installation report contains the following sections related to PLC communication:

e The entire system configuration (setup of stations and drivers)
o Objects sorted by PLC address

« Objects sorted by scan class
(the Scan intervals chosen on the Data Management Definitions tab in the
object properties dialog box)

e PLC communication efficiency information

For further details about the installation report, click here.

The setup of stations and drivers

This section of the report shows the settings defined for all stations and drivers.


def.chm::/DEF_CFG_Configuration_installation_report_Demo_prt.htm
def.chm::/DEF_CFG_Configuration_installation_report_Demo_prt.htm

IBSRLSE configuration

bherive profile org

Number of stations 5

Ftation name IGa55erver 1

Station type Iualized server

Station description -

LAN & -

LAN B -

MNumber of drivers 3

Driwver name OFC [(OLE For Process Control) Client side driwver ([YTOPC)
Driwer activation condition Operator station, 3erver or =ingle user

hecivation interwval 10 M=g. pr. channel 140 Jegment length G4
HodeO

alarmwaxpricrity u] alarmminpriority u] clockmaster u]
keepalivein u] keepaliveout u] manager 1
recwvdatagroup u] recwvlength 100 recvoffset u]
regsystemstart u] redqt imestamp u] redqtimesynch u]
subnodes - suspendnode u] useutctime 1

Objects sorted by data group

This section contains a list of all objects for which a PLC address has been defined. The objects
are sorted by data group. Notice that overlapping PLC addresses are marked with the word
Overlap in the last column.



Chjects

Data group, hode Address Length CUhiject name Atom
numher
a, o 0.0o0 2 TANEzZ RUTC Jtate
0.0o0 2 TANEzZ RUTC Command
0.0o0 2 TANE1AUTC Jtate
0.0o0 2 TANE1AUTC Command
0.0o0 2 TANEzZ RUTC Jtate
0.0o0 2 TANEzZ RUTC Command
0.0o0 2 TANE1AUTC Jtate
0.00 2 TLINE1AUTO Command
0.00 3 PETO1l-conn. SJtate
0.00 Z PETO1l-conn. Coneoand
0.00 18 P3TO1-LevelTotal 1 Val-in
50, 0 1.00 18 F3TO1-Level¥est 1 Wal-in
1.00 16 PITO1-Levelyest Val-in
a, 2 0.oo 3 PETOZ-conn. State
0.00 Z PETOZ—conn. Coneoand
0.00 16 PETOZ-LevelTotal Val-in
50, 2 1.00 18 FPSTOZ-LevelYest Wal-in
a, 3 0.oo 3 PETOS—conn. State
0.00 Z PETOS—conn. Coneoand
0.00 16 PETO3-LevelTotal Val-in
50, 3 1.00 16 PETOS-LevelYest Val-in
a, 1 1.00 16 PETO1-Level Hist Wal-in
1d, 1 1.00 16 P3TO1-LevelTotal Wal-in
o, o 0.o0o 4 Fanel-4 2 State
0.00 1 Fanel-4 2 Corroand
0.00 4 Fanel-4 1 State
0.00 1 Fanel-4 1 Corroand
0.00 4 Panel-4 State
0.00 1 Panel-4 Corroand
0.00 4 Panel-3 State
0.00 1 Panel-3 Corroand
0.00 4 Panel-2 State
0.00 1 Panel-2 Corroand
A omA a Tnm 1 A TSy

Objects sorted by scan class

The scan classes section of the report shows a list of scan records divided into the four scan

classes as shown below.

Manual

Manual

Manual

Hanual
Hanual
Hanual
Hanual
Hanual
Hanual
Hanual
Hanual
Hanual
Manual
Manual
Manual
Manual

Manual

Manual

Manual

Extern. type

FP1la
FP1la
FP1la
FP1la
FP1la
FP1la
FP1la
FP1lo
FP1lo
FP1lo
FP1lo
SATTANA
SATTANA
FP1lo
FP1lo
FP1lo
SATTANA
FP1lo
FP1lo
FP1lo
SATTANA
FPi6
FPi6
FPi6
FPi6
FPi6
FPi6
FPi6
FPi6
FPi6
FPi6
FPi6
FPi6

TTA £

rrerlap


igss.chm::/Help_Glossary_Query_scan_record.htm
igss.chm::/Help_Glossary_Query_scan_record.htm

Soan classes:

Drwv id: 15 Node nwmber: 13 Data group: o
Drwv id: 15 Node nwmber: 13 Data group: o
Drwv id: 15 Node nwmber: 13 Data group: o
Drwv id: 15 Node nwmber: 14 Data group: o
Drwv id: 15 Node nwmber: 14 Data group: 0O Word:3034 Length: 31
Drwv id: 15 Node nwmber: 14 Data group: o
Drwv id: 15 MNode nuwber: 113 Data group: o
Drwv id: 15 MNode nuwber: 113 Data group: o
Drwv id: 15 MNode nuwber: 113 Data group: o

Drwv id: 15 Node nwmber: 13 Data group: 0O Word:3094 Length: 1
Drwv id: 15 Node nwmber: 14 Data group: 0O Word:3094 Length: 1
Drwv id: 15 MNode nuwber: 113 Data group: 0O Word:3094 Length: 1

PLC communication efficiency information

Towards the end of the report, information about PLC communication efficiency is provided. The
system designer can use the efficiency figures found to optimize the use of the PLC memory
area. For both the parameters below, i.e. "Number of bits used for objects" and "Total number
of words in scan records”, the aim is to get the efficiency percentage as close to 100 % as pos-
sible. This will result in the most effective and speediest communication between IGSS and the
PLC.

The two efficiency percentages are calculated and used as follows:

Number of bits used for objects
The efficiency percentage is calculated as follows:

Number of bits used
Total number of bits

x 100

The percentage expresses how effectively the bits used for IGSS objects have been packed
within the data words read by IGSS. For example, if you're defining a digital object and only use
the first two bits in a data word for two different digital states, the remaining bits of the data



word are unused. Avoid unused bits by packing the word with digital states so that no bits
remain unused.

Note: If this percentage is higher than 100 %, it means that some PLC addresses are not

unique. In some cases, you can do this deliberately to save space in the PLC, but in other cases
it may mean that relevant data is overwritten.

Total number of words in scan records
The efficiency percentage is calculated as follows:

Total number of words

x100
Possible number of words withthe same number of scanrecords

The percentage expresses how many relevant data words IGSS has read within a scan record.
For example, if IGSS is reading 32 data words in one scan and only 25 of those are used for
IGSS objects, the PLC addressing can be optimized. The closer you get to 100 %, the more effi-
cient and faster the PLC address scanning takes place.

Closely related to these efficiency percentages is one of the key PLC design considerations.
When you plan the use of the PLC memory area, make sure that IGSS objects with the same
scan interval reside in the same data groups and words. This will reduce the number of scan rec-
ords and thus optimize communication between IGSS and the PLC.

Comrrunication effeciency in scan records:

MNurkber of bits used for okhjects: 4021

Total nuwber of bhits in scanrecords: I424
Effiency: 117%
Total nuber of words in scanrecords: 214
Pozzikble number of words with samwme nuber of scanrecords: 184

Effiency: 5e%




Chapter 6: Property Page Help

6.1 Access Control tab

SUper'u'ise&Languagel Startup | Data Collection I Reports
Station | Corfigurstion | Files | Access Control Alam

Access control
[7] Dizable access control Allow permanent user login

[7] Monitor mode only [] Cld style login
Save latest user logged in Force us

r dl program sianup

4]
(=)

Keep a record of all user activity in an audit trail database
Aptivity: Store audit trail Comment required

Cutput
Limits
Access

Motes and ack’s

Diata management

System

EEEEEHE
HEEEEEFE

days

—_

Keep audit trail for

Alam Management System and Super Alam server settings
[] Disable AMS interface

Admin
User TCPAIP port
=
[m] Default Port
Overview

The Access Control tab allows you to set up various parameters related to access control and
user administration. You can do the following tasks:

o Enable/disable user administration
e Set up various user administration options

« Enable and set up the Audit Trail database



e Set up users who can establish connections to IGSS servers from an AMS or Super

Alarm server

Field help

Group name

Field

Description

For user login at pro-
gram startup

This setting is only active on an operator sta-
tion.

Select this option to automatically activate
the user login dialog box when the user/op-
erator clicks on the IGSS Starter.

The requirement for using this feature is
that the User Administration module has
been set up with user names and passwords.




Monitor mode only

Select this setting to
restrict the operator
station from doing
anything but pas-
sively monitoring the
process on this PC.

Save latest user
logged in

Check this box to
have the system
automatically insert
the user name of the
latest user who
logged into the sys-
tem. Then the user
only needs to type
his password.

Allow permanent
user login

Check this box to
enable the Make
new user per-
manent option in
the Temporary
Login dialog box
which appears if the
user who is currently
logged in does not
have the right to per-
form a certain oper-
ation.

Instead, another
user with the nec-
essary privileges can
log in to do the oper-
ation. If the above
option is checked in
the dialog box, the
new user is logged in
permanently, that is,
also after the oper-
ation has been per-
formed.

Old style login

Check this box to use
the password pro-
tection concept from




the IGSS, version
8.x 16-bit Windows
edition. When ena-
bled, the user is only
prompted for a pass-
word when he logs
in. Normally, logging
onto an IGSS system
requires both pass-
word and user name.
If you use this
option, you must
define your users
with a user name but
no password in User
Administration.
When they log in,
they are only
prompted for a pass-
word which is iden-
tical to the user
name defined. the
IGSS, version 8.x
16-bit Windows edi-
tion. When enabled,
the user is only
prompted for a pass-
word when he logs
in. Normally, logging
onto an IGSS system
requires both pass-
word and user name.
If you use this
option, you must
define your users
with a user name but
no password in the
IGSS, version 8.x
16-bit Windows edi-
tion. When enabled,
the user is only
prompted for a pass-
word when he logs
in. Normally, logging
onto an IGSS system
requires both pass-

—— ———————————————




e your users with a
user name but no
password in e your
users with a user
name but no pass-
word in e your users
with a user name but
no password in

For user login at pro-
gram startup

This setting is only
active on an oper-
ator station.

Select this option to
automatically acti-
vate the user login
dialog box when the
user/operator clicks
on the IGSS
Starter.

The requirement for
using this feature is
that the User
Administration
module has been set
up with user names
and passwords.




Audit Trail Keep a record of all Select this check box to save user activity in
user activity in audit | the Audit Trail database.

trail database
You select which activities to save in the two
columns named Store audit trail and Com-
ment required below.

P R R e I e R i 6 Ll T e\




Type the number of days for which you want
to keep the user activity records in the Audit
Trail database.

Keep audit trail for
... (days)




Limits Store Comment
audit required
trail
Will save The user
all alarm must input
limit oper- | a com-
ations ment for

each oper-
ation.

Access Store Comment
audit trail | required
Will save The user
all user must input
access a com-
operations, | ment for
such as the | each oper-
user log- ation.
ging in and
out of the
system.

Also, auto-
matic log-
out of
users will
be
recorded
with this
option.

Notes and ack's Store audit Comment
trail required
Will save all The user
activities must input
where the a com-
user creates ment for
an object or each oper-
user note or ation.
acknowledges
an alarm.

Data management Store audit | Comment
trail required

_— e Y e — -




Will save all
data col-
lection and
logging activ-
ities. The
user can
start/stop
data col-
lection,
start/stop log-
ging on spe-
cific objects
or all objects
in the con-
figuration.
Those oper-
ations will be
recorded
under Data
Management.

Will save all
data col-
lection and
logging activ-
ities. The
user can
start/stop
data col-
lection,
start/stop log-
ging on spe-
cific objects
or all objects
in the con-
figuration.
Those oper-
ations will be
recorded
under Data
Management.

The user
must input
a com-
ment for
each oper-
ation.

The user
must input
a com-
ment for
each oper-
ation.

|




System

Store Comment
audit trail | required
Will save The user
all system | mustinput
operations, | a com-
such as ment for
starting each oper-
and stop- ation.

ping the

system.

... (days)

e ——

Keep audit trail for

Type the number of
days for which you
want to keep the user
activity records in the
Audit Trail database.




AMS and Super
Alarm server set-
tings

List of users

Lists the users who are authorized to estab-
lish connections to IGSS servers from AMS
or Super Alarm.

Disable AMS inter-
face

Select this check box to prevent users log-
ging onto the AMS server from using its user
interface.

Add... Click this button to create a new user who
will be authorized to establish connection to
an IGSS server from AMS or Super Alarm.

Edit... Allows you to edit the user name and pass-
word of the selected user.

Remove Removes the selected user from the list.

TCP/IP port

Specify the TCP/IP port which will be used
for communicating with the AMS or Super
Alarm server. This setting should only be
changed, if there's a conflict with the default
port number.

Default port

Click this button to insert the default port
number which is 12399.




Chapter 7: Importing and Exporting Settings

7.1 Import/Export files (*.ixd)

All settings defined in System Configuration can be exported and imported. You can -
e Export driver settings from v2 to an export file (*.ixd)
e Export driver settings from the current version to an export file (*.ixd)

e Import driver settings into the current version from either of the two sources above

7.2 Export IGSS v2 driver settings

You can export the driver settings from the active v2 driver profile for the purpose of importing
those settings into the current version. This function will read the settings for the active driver
profile in the Windows Registry.

1. Select Tools —» Export IGSS V2 Driver Settings. The Save As dialog box
appears.

2. Give the export file a meaningful name, for example, MyDrvSetupv2.idx and click
Save.

3. To import these settings, open the relevant configuration and select Tools — Import
IGSS Driver Settings.

7.3 Export IGSS v8 driver settings

You can export the driver settings to a file for the purpose of importing those settings into
another configuration. The typical case is when you are configuring the drivers at your own
office and want to copy these settings onto the IGSS server at the plant.

1. Select Tools — Export IGSS v8 Driver Settings. The Save As dialog box
appears.
2. Give the export file a meaningful name, for example, MyDrvSetupv8.idx and click
Save.

3. To import these settings, open the relevant configuration in the System Con-

figuration program and select Tools —» Import IGSS Driver Settings.



7.4 Import IGSS driver settings

You can now import the driver settings saved in an IGSS driver file (*.idx) exported from either
v2 or the current version.

Open the relevant configuration in the System Configuration program.
Select Tools - Import IGSS Driver Settings. The Open dialog box appears.

Find the relevant IGSS driver file (*.idx).

Hp N o=

Click Open. The settings are imported.



Chapter 8: Reference and Lookup

8.1 Conventions in this Manual

The following typographical conventions are used:

Convention Description Example
Userinter- | \yhen referring to labels and names
face ele- A . g The Data Management tab.
in the user interface.
ment
- T he followi iption:
. When the user has to type specific Vs el ClEilfel
Userinput | 4 tain1GSS
' Incoming flow in Tank 2
Module . . c .
name When referring to a module in IGSS Open the Definition module.
A note emphasizes or supplements . . . .
. . . By default, the timestamp is in universal time
important points of the main text. A 1 . .
Note . . . format, UTC-. This can be changed in the
note provides information that may . . .
. . Driver Log Filters dialog box.
apply only in special cases.
A tip suggests alternative methods
that may not be obvious in the user Alternative to this simple find
Ti interface. A tip also helps the user in function, you can also filter on
P working more effectively with IGSS. text in the messages in Driver
A tip is not essential to the basic Log Filters dialog box.
understanding of the text.
A warning is an important note that is
essential for the completion of a If you disregard the System
Warning task. In some cases, disregarding a alarm, you may risk loss of
warning may result in undesirable data in the LOG and BCL files.
functionality or loss of data.

luniversal Time Coordinated (formerly Greenwich Mean Time), used as the basis for calculating
time in most parts of the world. IGSS uses this time format internally in the database. You can
switch between UTC and local time by enabling or disabling the "UTC" field in various dialog
boxes in the system.



8.2 Getting Help in IGSS

IGSS comes with a comprehensive help system designed to help both system designers and
operators to get started with IGSS as quickly as possible.

Documentation overview

The IGSS documentation includes the following items:

Documentation item Description

An introduction to IGSS and its most fundamental terms and
features. Getting Started is intended to get you up and running
as fast as possible. The manual provides a system and archi-
tecture overview followed by a number of real-life use cases
you can go through before building your first real IGSS project.
The manual is available in Adobe Acrobat format (.pdf).

Getting Started

For each module there is a help file with the same name as the
module itself, for example, Igss.chm for the Master module,

Igss.exe.
Module help

The help file is invoked by clicking the 9 in the upper right
corner of the module. The Table of Contents will then allow you
to browse through the topics.

For each dialog box there is a help topic with the following
standard information:

Overview

Preconditions
Where do I find it?
Field help

Dialog box help

Dialog box help is invoked by clicking the help button 9 in the
upper right hand corner of the dialog box.

IGSS also provides thematic help. When there is a special
theme that requires special attention from the user, a ded-
icated help file is provided. Examples include "Driver-Specific
Help" and "Database Administration Help".

Thematic help

Where are the help files located?



The IGSS help files are located in the appropriate language folder under the [IGSS InstallPath].
The help files are available in English at release time.

The paths to the help files are:

Language Path
English [IGSS InstallPath]\ENG
Danish [IGSS InstallPath]\DAN
German [IGSS InstallPath]\DEU

Translated help files

Selected help files have been translated into Danish and German. If you require help files in
your language, please contact 7T.

Help updates

The IGSS help files are continuously updated and improved. Check regularly with the IGSS
Update module in the IGSS Start menu.

8.3 Version Information (IGSS Help System)
© 7-Technologies A/S, IGSS Version 9.0

The IGSS help files are based on software build number 10305 (initial release)

English help files

To update the help files, you must activate the IGSS Update module in the IGSS Start menu.

There must be a connection from the PC to the Internet. Every time IGSS Update is run, IGSS
help files as well as IGSS system files will automatically be updated on the PC from the 7-Tech-
nologies web server.

You select the languages you want to update in the Tools menu of the IGSS Update module.

If you are not able to update the IGSS system directly via the Internet, the alternative is to
download the updates from the 7-Technologies website as zip files. These can then be trans-
ferred onto a CD or USB memory stick, which is then the medium used to update on site.

After running IGSS Update, the build numbers in various IGSS modules may change to a
higher number. This signifies that the module in question has been updated with newer
files. Build numbers consist of four digits, where the first digit represents the year and the



last three represent the day number in the year in question. The build number can be
in the About dialog box which can be activated from the Help menu.

An example:

Build number = 10305
10 = the year 2010
210 = The 210D day of the year



Chapter 9: Glossary

A

Application menu

D

The Application menu is the first ribbon in the IGSS Master module. Click the icon to
drop down the menu. The menu contains items that were typically found in the File
menu in previous versions of IGSS. In most modules, an "Options" item allows the
user to define global module settings. The Application menu was introduced in the
Microsoft Office 2010 package. It replaces the Application button (nicknamed Dough-
nut) which was introduced in IGSS V7 and V8.

descriptor

Q

A descriptor is the graphical display of an object. IGSS includes many types of descrip-
tors including: - Built-in standard symbols - Animated symbols (Symbol Factory
library) - Graphics and animation - Drawing symbols - Windows controls - ActiveX con-
trols An IGSS object can be represented with different descriptors on different dia-
grams.

Quick Access Bar

You can customize the Quick Access Bar to include the functions you use most
frequently. Simply drag the relevant function from the ribbon to the Quick Access Bar.

R

Ribbon
The Ribbon is a new term/element in the Microsoft universe. The Ribbon replaces the
well-known toolbars in applications. The Ribbon provides quick access to the most
commonly used functions in the application. The Ribbon is divided into logical groups
(the tabs) and each tab is divided into sections (the blocks in the tab). The Ribbon is
context-sensitive which means that only relevant functions are accessible dependent
on the current user action.

S

SCADA

Supervisory Control & Data Acquisition



UTC
Universal Time Coordinated (formerly Greenwich Mean Time), used as the basis for

calculating time in most parts of the world. IGSS uses this time format internally in
the database. You can switch between UTC and local time by enabling or disabling the
"UTC" field in various dialog boxes in the system.
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